Graduate Admissions

Introduction to WebNow

Document Imaging

July, 2015
**Table of Contents**

Quick Steps: Step by Step Instructions .................................................................................. 1
Introduction to WebNow .............................................................................................................. 5
WebNow and PeopleSoft ............................................................................................................. 5
Obtain Access to WebNow ......................................................................................................... 5
Computer Requirements ........................................................................................................... 6
Log into WebNow ...................................................................................................................... 6
The WebNow Explorer Page ..................................................................................................... 7
View Your Workflow Queues ..................................................................................................... 8
Review an Application .............................................................................................................. 9
View Documents Related to the Application ........................................................................... 11
View the Next Related Document ............................................................................................ 13
Return to Open Documents ....................................................................................................... 13
Annotate a Document ............................................................................................................... 14
Close an Application ............................................................................................................... 15
Log Out of WebNow ............................................................................................................... 15
Enter an Admissions Decision (GPD only) ............................................................................. 16
Search for Documents No Longer in Workflow ................................................................. 17
Quick Steps: Step by Step Instructions

Log into WebNow
Note: The Chrome web browser may not be used with WebNow.
- Navigate to www.umb.edu/it
- On the left side of the page, under Getting Services, click on Campus Administrative Systems
- Bookmark this page.
- Scroll down to the Document Imaging section of the page and click on the WebNow login link.
- Enter your campus email user name (firstname.lastname only).
- Enter your campus email password.
- Select the Boston Campus.
- Click on Login.
- Wait for the WebNow Explorer page to open.

Log out of WebNow
- Return to the WebNow Explorer page.
- Click on Disconnect in the upper right corner of the page.
- WebNow will automatically close all open documents.

Open an Application
- On the left side of the WebNow Explorer page, click on + to expand Workflow.
- Click on + to expand UMB Graduate Admissions.
- Click on the queue you wish to access.
- Double-click on the application in the grid on the right side of the Explorer page.
- The application will open in a new window.

Set the Documents to Open Automatically in a Readable Size
- Click on the File menu at the top left of the application window.
- Click on Options. The Viewer Options box will appear.
- In Viewer Options, under the General tab, under Images, click on the Default size dropdown menu.
- Click on Fit Width.
- Click OK.
- A message will appear telling you that the change will not take effect until you close the document window and reopen it.
- Click OK.
- Close the application window.

July, 2015
In the WebNow Explorer grid, double-click on the application.
The application should open in a larger size and WebNow should remember this setting for future documents. Occasionally you may need to repeat these steps.

**Display a List of Documents Related to the Application**
- Click on the View menu at the top left of the window displaying the application summary.
- Click to place a checkmark next to Related Documents.
- Find the lower border of the application in your window. On a PC this will be identified by a blue line.
- Look at the far left end of the border. You should see “Related Documents” immediately beneath the border.
- Under the border, beneath a few icons, you will see a Relationship dropdown menu.
- Click anywhere in the dropdown menu.
- In the dropdown menu, click on Grad Admissions Docs UMB.
- A list of documents submitted by the applicant will appear. If the application is in the Applied and Processing queue, it is possible that no additional documents have been received.
- **If the lower border of the application is too far toward the bottom of the window, you may need to drag it up in order to see the list of related documents.**
- Click the File menu, then click the Options... menu item.
- Under Launching, click to place a check mark in the Run last viewed relationship checkbox.
- Click OK.
- Click the Save button on the left side of the toolbar at the top of the window or click on the File menu and then click Save.
- **Double-click on a related document.** It will open in a new window.

**View Pages in a Document**
- At the bottom left of a document window, you will see a navigation toolbar:
- Click on the right arrow to move to the next page in a document; click on the left arrow to move to the previous page.
- Alternatively, click in the dropdown menu to display a list of page numbers and click on the number of the page to which you want to move.

**Open the Next Related Document**
- Once you have opened an application, displayed the list of related documents and double-clicked to open a related document, you will be able to open the related documents without returning to the application.
- In the navigation toolbar at the bottom left of the related document window, click on the right double-arrow icon to open and move to the next related document in the list; click on the left double-arrow icon to open and move the the previous related document in the list.
**Annotate a Document**

Use the annotation icons in the toolbar at the top of a document window.

Icons available to all users: Stamp (to informally indicate a decision), sticky note; text box, highlighter, check mark, pen, rectangle, arrow, circle, hyperlink

Digital Signature icon is available only to the GPD

Click the icon to select the annotation, then click in your document where you want the annotation to appear.

Special instructions:

- **Stamp**: Click to select the icon; right-click on the icon to select the decision; click in the document.
- **Sticky Note**: If someone has already placed a sticky note on the document, double-click on it to open it. To add a comment, type in the upper text box, click Add, then click Close.
- **Highlighter**: Right-click on the icon to select a color. Drag over text in document to highlight it.
- **Hyperlink**: Click to select then icon; click in the document. Type in complete URL, beginning with http://

To delete an annotation: before you close the document, right-click on the annotation and select Delete, then click on Yes.

**Apply a Digital Signature (GPD only)**

- After opening the Application Summary from the Ready for Review queue, double-click on the Profile Sheet in the list of Related Documents list.
- Use the tools at the bottom of the Profile Sheet window to navigate to its last page.
- Using either the Sticky Note icon or the Text Tool in the toolbar at the top of the page, specify any conditions relating to the decision.
- You may apply a checkmark or stamp by right-clicking on the icon on the toolbar, selecting the appropriate option and clicking on the Profile Sheet.

- Click on the Digital Signature icon on the toolbar at the top of the page.
- Important: Do not use the Digital Signature icon in the File menu or in the Actions panel.

- Click the Profile Sheet on the “Graduate Program Representative” line.

- The first time you click on the Digital Signature icon, you will need to create a password. The password need not be the same as your email password and will not automatically be updated when you change your email password.

- Enter the password a second time to confirm. Each time you click on the Digital Signature icon, you will need to enter this password.

- Click on the dropdown menu in the Digital Signature box and select the appropriate decision.

- Click OK. The document is now locked.
• Close the Profile Sheet and return to the Application Summary.

• Send the application back to the Graduate Admissions Office by clicking on the Route Forward button located at the bottom of the document

  or

  Right-click on the application, click on Workflow, then click on Route Forward.

• The application will be removed from the Ready for Review queue. You will still be able to view the documents by searching for them in WebNow.

Search for a Document in WebNow
Once the GPD enters a decision using his/her digital signature and routes the application forward to the Graduate Admissions Office, the application and its related documents are moved from workflow to the document repository. To search for a document:

• In the left panel of WebNow Explorer, click on the + next to Documents to expand the view and display the programs to which you have access.

• Click on a program. The applicants who have applied to that program will be displayed in the grid on the right.

• You may locate the documents you want by sorting on Term and/or Name and/or ID and scrolling through the list or you may use the Quick Search function at the top right.

• In the Quick Search tab on the top right of the ImageNow Explorer, click on the dropdown and select the search criterion, such as Student ID or Student Name.

• In the operator dropdown menu, it is recommended that you select “Contains.”

• In the text box, type the search value.

• Click on Go.

• The application(s) matching your search criterion will be listed.

• Double-click on an application to display it in a new window.

• If the related documents are not automatically listed, follow the instructions above to display them.
Introduction to WebNow

WebNow is the web-based document imaging software used to access graduate admissions applications. To expedite the process of reviewing applications and to protect the applicants’ personal data, application documents are stored and viewed on line. Documents in WebNow may only be viewed; they may not be printed.

The document imaging system functions through “workflow,” using “queues” that automatically route a specific document to the users who need to view it in the Graduate Admissions Office and in the academic departments. Admissions decisions are submitted electronically through WebNow by the Graduate Program Director to the Graduate Admissions Office.

WebNow and PeopleSoft

The document imaging system works in conjunction with the admissions module in the student administration system (PeopleSoft). An application is created and saved in PeopleSoft, along with a checklist that keeps track of the documents that an applicant is required to submit. PeopleSoft generates a letter to the applicant containing a pin number, which the applicant can use to view the status of his/her checklist on the UMass Boston web site. As documents are received and stored in the document imaging system, each one is linked to the application in PeopleSoft and the checklist is updated. Several “missing requirements” letters are generated in PeopleSoft and sent to the applicant, letting them know what information is still missing in their application packet.

In the document imaging system as admissions documents are received, they are routed to the appropriate queues. The Graduate Program Director is notified by email when an application is complete and ready to be reviewed. The GPD uses his/her digital signature to record a decision in WebNow and then electronically routes the document back to the Graduate Admissions Office. The Graduate Admissions Office staff updates the application in PeopleSoft and the student administration system generates the appropriate decision letter, which the Graduate Admissions Office mails to the applicant.

Obtain Access to WebNow

To obtain access to the system for himself/herself, admissions committee members and support staff, the Graduate Program Director should send an email to the Graduate Admissions Director and data custodian, Peggy Roldan Patel, at peggy.patel@umb.edu. The message should contain:

- The name of the program(s) for which access is requested
- The names of the users and an indication whether each one is a Graduate Program Director (GPD) or an admissions committee member or staff member
- The employee ID (available on each employee’s pay advice in HR Direct) of each user

Once access has been approved and set up, the new user will receive a confirming email from the security administrator in IT.
Computer Requirements

WebNow on a Mac
Although WebNow was designed for a PC, you should be able to perform most functions on a Mac. Occasionally IT will post special instructions on the WebNow Help page for Mac users.

Web Browser
The supported web browser is Internet Explorer. You are welcome to try using Firefox or, on a Mac, Safari. You may not use Chrome. Sometimes automatic updates to a web browser will affect WebNow’s performance. If you find that you are unable to access the system properly, please try switching to a different web browser. When an update to a web browser affects WebNow’s performance and requires changing the browser’s settings, IT will post instructions on the WebNow Help page and the Graduate Admissions Director will send an email to all users.

Java
WebNow runs on Java, a product owned and frequently updated by Oracle, Inc. It is important for the version of Java on your computer to be up-to-date and that you do not have multiple versions of Java installed.

If you see a message indicating that Java may require updating, please follow the instructions on your screen. As Java updates occur and require updating Java’s settings, IT will post new instructions on the WebNow Help page and the Graduate Admissions Director will send an email to all users.

Getting Help
For assistance with WebNow, contact the IT Service Desk (itservicedesk@umb.edu; 617-287-5220). An IT staff member will get in touch with you. Please copy Peggy Roldan Patel (peggy.patel@umb.edu), Director of Graduate Admissions, on your messages to the IT Service Desk.

Log into WebNow

- Navigate to: www.umb.edu/it
- On the left side of the page, click on Campus Administrative Systems.
- Please bookmark this page.
- Scroll down to the Document Imaging section in the center portion of the page.
- Click on the login link to WebNow.

Log into WebNow with your campus email user ID (firstname.lastname only) and your campus email password. On the login page you will also be required to select the Boston campus.

Note that it may take several minutes for WebNow to appear. You may see a blank screen for a few minutes. Please be patient. The more frequently you access WebNow, the more quickly it will open.

If a security warning appears, click the checkbox and click Run.
If the process is going well, you will see a Java icon.

The WebNow Explorer Page

The WebNow Explorer page will open displaying two panels. The right panel will be blank initially. On the left panel, you will see two main menu options: Documents and Workflow.

Workflow provides access to current applications on which your department has not yet made a decision. Once you make a decision on an applicant, the application and its related documents, such as test scores, transcripts and letters of recommendation, are removed from workflow. They are stored in a document repository in the document imaging system. You may retrieve them at any time by using the Documents function.

Begin by displaying the academic programs listed under Workflow.
View Your Workflow Queues

Click on the + to expand Workflow.
Click on the + to expand UMB Grad Admissions

For each academic program to which you have been given access, you will see two queues: UMBGA Applied and Processing and UMBGA Ready for Review. To see the full names of the queues, you may need to drag the vertical border of the panel to the right.

The Applied and Processing queue contains all the active applications received for the program, along with related documents such as test scores and letters of recommendation. The applications in the Applied and Processing queue are not complete. They are missing one or more of the required checklist items specified for the academic program. You will not be able to enter a decision on an application in the Applied and Processing queue. However, you may want to review the incomplete applications so that you can encourage, by phone or email, any promising applicants. When all required documents have been received, the application is moved into the Ready for Review queue.

The Ready for Review queue contains complete applications on which you may now make a decision. When all of the required checklist items have been received, the PeopleSoft admissions module marks the application as complete and generates the Profile Sheet. The Profile Sheet contains a summary of the applicant’s data and fields where the GPD enters the admissions decision and specifies any conditions attaching to the decision. In the final step of the WebNow process, the GPD electronically routes the application back to the Graduate Admissions Office. Graduate Admissions staff members update the application in PeopleSoft with the decision and PeopleSoft generates an appropriate decision letter, which the Graduate Admissions Office mails to the applicant. The application and all of its accompanying documents are removed from workflow, but may be accessed in the document repository.

The Graduate Program Director will receive an email from the document imaging system when:
- An application is added to the Applied and Processing queue
- A new related document is linked to an application
- An application is moved from the Applied and Processing queue to the Ready for Review queue
- The GPD applies a digital signature to a Profile Sheet and sends the application back to the Graduate Admissions Office in a program for which he/she is not the GPD
Review an Application
The procedure for viewing documents in both queues is the same.

1. **Click on the workflow queue you wish to view.** The applications in the queue will be listed in a grid in the panel on the right or you will see the message “No documents in queue.”

Each row in the grid represents an application. The columns contain the following information:

<table>
<thead>
<tr>
<th>Time In Queue</th>
<th>Student ID</th>
<th>Student Name</th>
<th>Term</th>
<th>Status</th>
<th>Pages</th>
<th>Scan Date/Time</th>
<th>Notes</th>
</tr>
</thead>
</table>

**Term** indicates the term for which the applicant is applying.
**Status** is usually “idle,” indicating that no one else has the document open. If a document is open, it will have a status of “working” and you will be offered the option of viewing it in Preview mode.
**Pages** indicates the number of pages in the application.
**Notes** are sometimes entered by Graduate Admissions.

Note: The grid is similar to an Excel spreadsheet:
- To change the sort order of a column, click on the column heading.
- To rearrange the columns, drag the column heading to a new location.
- To change the width of a column, drag the border of the column right or left.

2. **Double-click on the application you wish to view.** It will open in a new window.

3. **Adjust the size of the document.**
   - Click on the File menu at the top left of the window.
   - Click on Options. The Viewer Options box will appear. (See image below.)
   - In Viewer Options, under the General tab, under Images, click on the Default size dropdown menu.
   - Click on Fit Width.
   - Click OK.
   - A message will appear telling you that the change will not take effect until you close the document window and reopen it.
   - Click OK.
   - Close the application window.
   - In the WebNow Explorer grid (where you started), double-click on the application.
   - The application should open in a larger size and WebNow should remember this setting for future documents. Occasionally you may need to repeat these steps.
4. **Move through the Pages of the Application**

At the bottom left of the document window, you will see a toolbar containing several icons you can use to page through the document.

To go to another page in the document, click on the dropdown menu in this toolbar and click on the page you want to see.

To move to the next page, click on the arrow pointing to the right.
To move to the previous page, click on the arrow pointing to the left.
View Documents Related to the Application

1. Click on the View menu at the top left of the window displaying the application summary.
2. Click to place a checkmark next to Related Documents.

3. Find the lower border of the application in your window. On a PC this will be identified by a blue line.
4. Look at the far left end of the border. You should see “Related Documents” immediately beneath the border.
5. Under the border, beneath a few icons, you will see a Relationship dropdown menu.
6. Click anywhere in the dropdown menu.
7. In the dropdown menu, click on Grad Admissions Docs UMB.
If there are any documents related to this application, they will be listed. If the application is in the Applied and Processing queue, it is possible that the applicant has not yet submitted any additional documents. You will see a message indicating that there are no related documents. If the application is in the Ready for Review queue, you should see the Profile Sheet listed among the related documents.

If the lower border of the application is too far toward the bottom of the window, you may need to drag it up in order to see the list of related documents.

Point your mouse to the border and wiggle the mouse until you see a two-headed arrow. Then, drag the border toward the top of the screen until you can see the list of related documents.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Scan Date/...</th>
<th>Term</th>
<th>Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRE Score (Official)</td>
<td>12/06/2013</td>
<td>1... 2014 Fall</td>
<td>Shared</td>
</tr>
<tr>
<td>Letter of Recommendation</td>
<td>10/01/2013</td>
<td>0... 2014 Fall</td>
<td>Exercise &amp; Health Sci...</td>
</tr>
<tr>
<td>Letter of Recommendation</td>
<td>10/02/2013</td>
<td>0... 2014 Fall</td>
<td>Exercise &amp; Health Sci...</td>
</tr>
<tr>
<td>Resume</td>
<td>10/01/2013</td>
<td>0... 2014 Fall</td>
<td>Exercise &amp; Health Sci...</td>
</tr>
<tr>
<td>Statement of Purpose</td>
<td>09/30/2013</td>
<td>1... 2014 Fall</td>
<td>Exercise &amp; Health Sci...</td>
</tr>
</tbody>
</table>

Note that in the Plan column, “Shared” indicates that the applicant has applied to more than one program at UMass Boston and that particular document has been made available to all the programs.

8. Click the **File** menu, then click the **Options** menu item.
9. Under **Launching**, click to place a check mark in the **Run last viewed relationship** checkbox.
10. Click **OK**.
11. Click the **Save** button on the left side of the toolbar at the top of the window or click on the **File** menu and then click **Save**.
12. **Double-click on a related document**. It will open in its own window. It will be identified in the task bar at the bottom of your screen when you point to this icon:
The related document window will display the same navigation toolbar as the application window.

**View the Next Related Document**

In the navigation toolbar at the bottom of a related document, click the double-headed arrows to move to the next or to the previous related document.

<table>
<thead>
<tr>
<th><img src="image1" alt="Related Documents" /></th>
</tr>
</thead>
</table>

**Return to Open Documents**

When you log into WebNow, the first window that opens is called the WebNow **Explorer** window and it will remain open until you disconnect from WebNow. You will always return to it to open new applications and to disconnect from the system. You will find it, on a PC, by pointing to the web browser icon in the task bar at the bottom of your screen. The Explorer window will be entitled “WebNow 6” and will have a “sun” icon 🌞, as shown here:

![Explorer Window](image2)

When you double-click on an application in the Explorer grid, the application will open in a separate window. Then, as you open other documents related to the application, such as letters of recommendation, each document will open in its own window.

These “viewer” windows will be represented, on a PC, in the task bar at the bottom of your screen by this icon:

![Task Bar Icon](image3)

When you point to the icon, the windows you have open will appear. Each window will be identified by document type, such as application or letter of recommendation. Click on a window to return to it.
At the very bottom of the document window you will see identifying information, including the applicant’s name, ID number, term, the number of pages in the document and the queue in which the document resides.

You may have only one application, with its related documents, open at a time.

**Annotate a Document**

A toolbar at the top of each document allows you to annotate the document. It is a good idea for admissions committees to agree beforehand on how they will use the annotations. Annotators should be aware that it is possible that the applicant may one day see the annotation.

To delete an annotation, right-click on it and select **Delete**, then click on **Yes**.

<table>
<thead>
<tr>
<th>Digital Signature: Only the Graduate Program Director will have access to this icon. Click to select the icon. Click on the last page of the Profile Sheet where you want the digital signature to appear. The first time you apply your digital signature, you will be asked to enter and then re-enter a password. Each time you click to apply the digital signature, you will be asked to enter your password first.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stamp:</strong> Allows you to (informally) indicate a decision. Click to select the icon, then right-click on the icon and select the decision. Click in the document where you want the stamp to appear.</td>
</tr>
<tr>
<td><strong>Sticky Note:</strong> Allows multiple users to add text to a text box. As you add a comment, the system will add your Employee ID and the date and time to the comment. Click to select the icon, then click in the document where you want the sticky note to appear. A small dialogue box will open. In the Add Text box, enter your comment. Then click Add. Your comment, along with your Employee ID and the date, will move to the History box. Click Close. You can open a sticky note by double-clicking on it. The History box will display existing comments and you can add to them by typing in the Add Text box. You can print the contents of a sticky note by clicking on the Print button in the dialogue box.</td>
</tr>
</tbody>
</table>
**Text Tool:** Allows you to create a text box. Click to select the icon. Click in the document where you want the text to appear. Type your text. You may drag the text box to a new location.

**Highlighter:** Allows you to highlight in color a portion of a document. Right-click on the icon to select a color. Click on the icon. Drag your mouse over the portion of the document you wish to highlight.

**Checkmark:** To place a checkmark in your document, click to select the icon, then click where you want the checkmark to appear. You can drag the borders to change the size of the checkmark.

**Pen:** Use this tool to “write” or scribble on your document. Click the icon to select it, then begin to drag your mouse in your document.

**Straight Line:** Click the icon to select it. Then drag your mouse to draw a straight line in your document.

**Arrow:** Click on the icon to select it. Then drag your mouse to draw an arrow in your document.

**Rectangle:** Click on the icon to select it. Then drag your mouse to draw a rectangle in your document.

**Circle:** Click on the icon, then drag your mouse to draw a circle or oval in your document.

**Hyperlink:** Click on the icon, then click in your document. Then enter a complete hyperlink, beginning with `http://`

---

**Close an Application**

When you have finished with an application, click on the red X in the application window and in the document windows. Return to the WebNow Explorer window to open another application.

**Log Out of WebNow**

Return to the initial Explorer window and click **disconnect** in the top right corner of the window.

```
options ▾ | help ▾ | disconnect
```

The system will automatically close any open document windows.

**Do not simply click on the red X** in the top right corner of the Explorer window to close WebNow.
Enter an Admissions Decision (GPD only)
Only the Graduate Program Director may enter an admissions decision.

1. After opening the Application Summary from the Ready for Review queue, double-click on the Profile Sheet in the list of Related Documents list.
2. Use the tools at the bottom of the Profile Sheet window to navigate to its last page.
3. Using either the Sticky Note icon or the Text Tool in the toolbar at the top of the page, specify any conditions relating to the decision.
4. You may apply a checkmark by clicking on the icon in the toolbar and then clicking in the checkbox. You may adjust the size of the checkmark with your mouse. Apply a stamp by right-clicking on the stamp icon on the toolbar, selecting the appropriate option and clicking on the Profile Sheet.

5. Click on the Digital Signature icon on the toolbar at the top of the page. Important: Do not use the Digital Signature icon in the File menu or in the Actions panel.

6. Click the Profile Sheet on the “Graduate Program Representative” line.

7. The first time you click on the Digital Signature icon, you will need to create a password. The password need not be the same as your email password and will not automatically be updated when you change your email password.

8. Enter the password a second time to confirm. Each time you click on the Digital Signature icon, you will need to enter this password.

9. Click on the dropdown menu in the Digital Signature box and select the appropriate decision.

10. Click OK. The document is now locked.
11. Close the Profile Sheet and return to the Application Summary.

12. Send the application back to the Graduate Admissions Office by clicking on the Route Forward button located at the bottom of the document
    Or
    Right-click on the application, click on Workflow, then click on Route Forward.

13. The application will be removed from the Ready for Review queue. You will still be able to view the documents by searching for them in WebNow.

Note: This last step is very important. The applicant will not be notified of your decision until the Graduate Admissions Office staff is able to view your decision.

The Graduate Admissions Office will update the applicant’s record in PeopleSoft. The student administration system will generate the appropriate decision letter, which Graduate Admissions will mail to the applicant.
Search for Documents No Longer in Workflow

Once the GPD has entered a decision, the application and its related documents will no longer be listed in the Ready for Review queue. You may, however, retrieve a document from the Document Repository. Although it is possible to perform complex searches using multiple search criteria, in most cases you will be able to retrieve the documents you need by entering the applicant’s name or ID number.

Quick Search

In the left panel of WebNow Explorer, click on the + next to Documents to expand the view.

You should see listed each program to which you have access.

Click on the program. The applicants who have applied to that program will be displayed in the grid on the right.

You may locate the documents you want by sorting on Term and/or Name and/or ID and scrolling through the list or you may use the Quick Search function at the top right.

In the Quick Search tab on the top right of the ImageNow Explorer, click on the dropdown and select the search criterion, such as Student ID or Student Name.

In the operator dropdown menu, it is recommended that you select “Contains.”

In the text box, type the search value.

Click on Go.

Your search results will be displayed in the grid on the right.
Double-click on an application to open it in a new window. Related documents may be accessed in the same way that you opened them in workflow.